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• USB programming cable with 10-pin header.

• Cat. 5 Ethernet crossover cable.

• Getting Started instructions.

• Rabbit 4000 Processor Easy Reference poster.

• Registration card.

Network Storage Center Setup
1. Install the hard drive in the Network Storage Center as shown at right.
2. Plug in the AC power adapter and use either a straight-through or a cross-

over Ethernet cable to connect the Network Storage Center to your PC.
3. If you are using Windows Vista, set the firewall to “Private.”
4. Install the IP Scanner utility from the setup CD that came with the Network 

Storage Center.
5. Use the on/off switch to turn the Network Storage Center on, then restart 

your PC to obtain a new IP address from the Network Storage Center.

6. Point your Web browser to http: //169.254.0.1/. A login dialog will 
appear. The default username and password are both admin.

7. Change the Host Name to thindrive to match the Dynamic C REMOTE_
SERVER macro in the LIB\ThinShare\SMB_CONFIG.LIB library.

8. Click on Samba Server and add SAMPLES to the folder list.

TIP: The Network Storage Center has a DHCP server. Leave the DHCP 
server on the Status tab enabled as long as you plan to connect the 
RCM4010 directly to the Network Storage Center or via a network 
without a DHCP server. You must disable the Network Storage Center’s 
DHCP server if your connection to the RCM4010 is via a network with a DHCP server. 

Where Do I Go From Here?
You are now ready to run the SMB sample programs in the Dynamic C SAMPLES\ThinShare folder. Use either a 
straight-through or a crossover Ethernet cable to connect the Network Storage Center to the RCM4010 Ethernet jack.

TIP: The sample programs assume that the Network Storage Center and the RCM4010 will be connected 
with a DHCP server present. If you make a direct connection where there is no DHCP server, change the 
TCPCONFIG 3 macro in the sample programs to TCPCONFIG 1 before you compile and run the sample 
programs. You will have to assign a static IP address (default IP 10.10.60.100, Subnet Mask 255.255.255.0, 
and Gateway 10.10.6.1) to the Network Storage Center.

The SMBSHELL.C is a good first sample program to run to display an interactive command-line shell with a large 
number of common SMB commands in the Dynamic C STDIO window.

If the sample program ran fine, you are now ready to go on to other sample programs and to develop your own appli-
cations. The source code for the sample programs is provided to allow you to modify them for your own use. The 
Embeo Getting Started and Samples manual and ThinShare User’s Manual on the supplemental CD contain addi-
tional setup information, describe the sample programs, and provide a complete technical reference for the ThinShare 
library and function calls. The RCM4000 User's Manual on the Dynamic C CD also provides complete hardware 
reference information and describes the software function calls for the RCM4010 RabbitCore modules and the Proto-
typing Board. The Setup CD has a reference manual for the Network Storage Center.

If there are any other problems:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Semiconductor Technical Bulletin Board and forums at www.rabbit.com/support/bb/ and at 
www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.

NOTE: If you purchased your SMB Application Kit through a distributor or through a Rabbit partner, contact 
the distributor or partner first for technical support.
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Installing Dynamic C®

Insert the Dynamic C CD from the Appli-
cation Kit in your PC’s CD-ROM drive. If 
the installation does not auto-start, run the 

.

Rabbit, RabbitCore, Dynamic C, and Digi are registered trademarks of Digi International Inc.

Visit our online Rabbit store at www.rabbit.com/store/ for 
the latest information on peripherals and accessories that 
are available for all RCM4000 RabbitCore module models.

setup.exe program in the root directory 
of the Dynamic C CD. Run the executable 
from the supplemental CD to install the 
SMB software after you install Dynamic C
SMB Network Storage Application Kit
The SMB Network Storage Application Kit allows you to add an SMB server to a Rabbit-based system 
that enables file sharing to add attached storage. Sample programs show you how to create a new file on 
the server and write data to it, and provide an interactive command-line shell.

Application Kit Contents
• 2 CD-ROMs — Dynamic C® with complete product documentation on disk, and supplemental CD 

with sample programs and information related to the SMB Application Kit.

• Network Storage Center with AC power supply, international adapter plugs, setup CD, and instruc-
tions.

• 3.5" IDE hard drive.

• RCM4010 RabbitCore® module.

• Prototyping Board.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., and 
European style plugs). Application Kits sold in North America may contain an AC adapter with 
only a North American style plug.

• Bag containing accessory parts, screws, washers, and standoffs.

Quick Start Guide
1. Install Dynamic C, then run the executable on the supplemental CD to add the SMB Application Kit soft-

ware.

2. Attach RCM4010 module to Prototyping Board, connect programming cable to PC, connect AC adapter.

3. Install the hard drive in the Network Storage Center and configure the Network Storage Center via your PC.

4. Use an Ethernet cable to connect the RCM4010 to the configured Network Storage Center

5. Explore the sample programs in the Dynamic C SAMPLES\ThinShare folder.

http://www.zworld.com/support/bb/index.html
http://www.rabbitsemiconductor.com/forums/
http://www.rabbit.com/support/questionSubmit.shtml
http://www.rabbit.com/store/


Step 4 — Connect Power
her connections have been made, you can connect power to the Prototyping Board.

 universal AC adapter, prepare the AC adapter for the country where it will be used by 
propriate plug. Snap in the top of the plug assembly into the slot at the top of the AC 
n in Figure 3, then press down on the plug until it clicks into place.

C adapter to 3-pin header J1 on the Prototyping Board as shown in Figure 3 above. The 
 be attached either way as long as it is not offset to one side—the center pin of J1 is 
ted to the positive terminal, and either edge pin is ground.

 adapter. The PWR LED on the Prototyping Board next to the power connector at J1 
. The RCM4010 and the Prototyping Board are now ready to be used.

A RESET button is provided on the Prototyping Board next to the battery holder to allow a hard-
 reset without disconnecting power.

ple Program
4010 is connected as described in the preceding pages, start Dynamic C by double-clicking 
 C icon on your desktop or in your Start menu. Dynamic C uses the serial port specified 

ion. Select the “Communications” tab and verify that Use USB to Serial Converter is 
ort the USB programming cable. Click OK.
nu to open the sample program PONG.C, which is in the Dynamic C SAMPLES folder. 
ey F9 to compile and run the program.The STDIO window will open on your PC and will 
square bouncing around in a box.
ting
annot find the target system (error message "No Rabbit Processor Detected."):

e RCM4010 is powered correctly — the red PWR LED on the Prototyping Board should be 
RCM4010 is mounted on the Prototyping Board and the AC adapter is plugged in.
ends of the programming cable to ensure that they are firmly plugged into the PC and the 
ector, not the DIAG connector, is plugged in to the programming port on the RCM4010 
ked (colored) edge of the programming cable towards pin 1 of the programming header.
he RCM4010 module is firmly and correctly installed in its socket on the Prototyping Board.

 compiles and loads, but then loses target communication before you can begin debugging, it 
at your PC cannot handle the default debugging baud rate. Locate the Serial Options dia-
namic C Options > Project Options > Communications menu. Select a slower 
ad baud rate, or choose a lower debug baud rate, then click OK.
Hardware Connections
Step 1 — Prepare the Prototyping Board
To facilitate handling the Prototyping Board, snap in four plastic 
standoffs to the four holes at the corners from the bottom side of 
the Prototyping Board as shown in Figure 1.

Step 2 — Attach Module to Prototyping Board
Turn the RCM4010 module so that the mounting holes of the 
RCM4010 line up with the corresponding holes on the Proto-
typing Board. Insert a standoff as shown, then insert the mod-
ule’s header J3 on the bottom side into header socket RCM1 
on the Prototyping Board.

NOTE: It is important that you line up the pins on header J3 of the RCM4010 module exactly with socket RCM1 on the 
Prototyping Board. The header pins may become bent or damaged if the pin alignment is offset, and the module will not 
work. Permanent electrical damage to the module may also result if a misaligned module is powered up.

Figure 2.  Install the RCM4010 Module
on the Prototyping Board

Figure 3.  Connect Programming Cable and 
Power Supply

Figure 1.  Insert Standoffs

 �

��

���

 ��

+, 

-�

.�

&�

+, 

&�

-%
�

&�

 �

-%
�

&"
/�
���
0

-�

��

1#�

�

��
�!�!#

�2
 �#
2 

#2
&��
�2
&

+,
 

-"
.2
�3

�24�

�2
45

&2
"�

�24�

�2��

&2
�3

.2�)

.2�)

.2��

.2�"

.2�'

�253

&2
�3

&2
�5�2'5

.2
"$

�2
4$

+, 

+, 

+, 

�

��"���������

&2�� �255

� ��
5

��
4

-%�$

&2�$

�25$
�25� &2�5

 ��

����

 ��

-�

.2"3 .2".2"5

/$�0

+, 

/����0
�&(�

.�

6��#78.#

6�89�

01*#
!2#

%*�

%*�

%*$

%*5

%1�

%1�

%1$

%15

%&�

%&�

%&$

%&5

%!�

%!�

%!$

%!5

% �
:,�
% �
:,�
% $
:,$
% 5
:,5

0�!;

+, 

6����

6����	


%*)

%*�

%*"

%*'

%1)

%1�

%1"

%1'

%&)

%&�

%&"

%&'

%!)

%!�

%!"

%!'

% )
:,)
% �
:,�
% "
:,"
% '
:,'

&0#

��
�

-%
�"

-%
�� &�
"

&�
�

&�
) &4 &5 &3 &�
�

&�
�

��)

�4 �' �" �� �$ �5

��)

��
4

��
'

��
"

��
�

��
$

��
5

��3

-%
��

-%
�$

-%
�3

-%
��


��
�


��
�


��
�

-%
��

��3

�3

�2$5�2$$
�235

�2"3

.2
��

.2
��

�2
43

.2�

.2
�5

.2
"�

.2
"�

�2
'�

�2
'$

�2
'�

�2$3

��
'

��$

<�

&�$

&�
3

&�
)

.�
&�4 &�

5

-%�'
-%'
-%$


���
-%"
-%�


���
-%4
-%5

-%�4
-%3

-%�)

&�'

:�&'

&$

*+
, &0
#

:,
'�,

:,
"�,

:,
��,

:,
)�,

0�
!;

:,
5�,

:,
$�,

:,
��,

:,
��,

*+
, 

*+
, 

��
�
��
�

�2
"5

�2"�

 
�

�
�

���

 ��

+, 

-�

.�

&�

+, 

&�

-%
�

&
�

 
�

-%
�

&
"

/�
��
�0

-�

�
�

1#�

�

��
�!�!#

�
2
 
�#
2
 

#
2
&
���
2
&

+
,
 

-"
.
2
�3

�24�

�
2
45

&
2
"�

�24�

�2��

&
2
�3

.2�)

.2�)

.2��

.2�"

.2�'

�253

&
2
�3

&
2
�5�2'5

.
2
"$

�
2
4$

+, 

+, 

+, 

�

��"������
���

&2�� �255

�

�
�5

�
�4

-%�$

&2�$

�25$
�25� &2�5

 ��

����

 ��

-�

.2"3 .2".2"5

/$�0

+, 

/����0
�&(�

.
�

6��#78.#

6�89�

01*#
!2#

%*�

%*�

%*$

%*5

%1�

%1�

%1$

%15

%&�

%&�

%&$

%&5

%!�

%!�

%!$

%!5

% �
:,�

% �
:,�
% $
:,$
% 5
:,5

0�!;

+, 

6����

6����	


%*)

%*�

%*"

%*'

%1)

%1�

%1"

%1'

%&)

%&�

%&"

%&'

%!)

%!�

%!"

%!'

% )
:,)

% �
:,�
% "
:,"
% '
:,'

&0#

��
�

-%
�"

-%
�� &
�"

&
��

&
�) &
4

&
5

&
3

&
��

&
��

��)

�
4

�
'

�
"

�
�

�
$

�
5

��)

�
�4

�
�'

�
�"

�
��

�
�$

�
�5

��3

-%
��

-%
�$

-%
�3

-%
��


�
��


�
��


�
��

-%
��

��3

�3

�2$5�2$$
�235

�2"3

.
2
��

.
2
��

�
2
43

.2�

.
2
�5

.
2
"�

.
2
"�

�
2
'�

�
2
'$

�
2
'�

�2$3

�
�'

��$

<�

&�$

&
�3

&
�)

.�

&�4

&
�5

-%�'
-%'
-%$

���
-%"
-%�

���
-%4
-%5
-%�4
-%3
-%�)

&�'

:�
&'

&$

*+
,
 

&
0
#

:,
'�
,

:,
"�
,

:,
��
,

:,
)�
,

0
�
!
;

:,
5�
,

:,
$�
,

:,
��
,

:,
��
,

*
+
,
 

*
+
,
 

�
��

�
��

�
2
"5

�2"�

�
�"

&
4

&
5

&
3

&��

&�"

:'

:5

&�$

&
��:$

:"

�
�)

-�

&
"�

�
�$

 
�
�

 
�
�

��5

��'

*
&
#

:�,
=

&
5�

>
�

&5�

.
�5

&
''

�"'

.�4

�
"5

&
$�

&
$"

&
$�

&
$�

&
$)

&"3

&"5

&
"4

.
5 &"�

&"�

.
'

&�"
&�$

>
�

.
$

�
�$

&
��

�
�"

&
�)

<
�

#
�

&�4

:� �5
�'

:�

&
�'

&��

:3:4

�
$

�
"

�
�

�
�

�
�

�
4�$�&
�)

.
�

�
3

�
�)

-%�

-%�

-%
�

.
�

&��
&��

�
%
�

�"�

 
�

�
�5��4-%"��� ���

���

>
�

�
"4
&
$$ &$' &"'

&"$&"".
3

��)

&�4

.
4

&�'

�
�'

&��

&
�)

&
��

��3

&
�3

&
�4

&
�'

&
�5

&�"
&�$

-�

�������


���

����������������
����������������
����������������� �!"

#�������� �!�$$�
%������
��������������� �!
�������������� �!"

 
�

�
�

���

 ��

+, 

-�

.�

&�

+, 

&�

-%
�

&
�

 
�

-%
�

&
"

/�
��
�0

-�

�
�

1#�

�

��
�!�!#

�
2
 
�#
2
 

#2
&
���
2
&

+
,
 

-"
.
2
�3

�24�

�
2
45

&
2
"�

�24�

�2��

&
2
�3

.2�)

.2�)

.2��

.2�"

.2�'

�253

&
2
�3

&
2
�5�2'5

.
2
"$

�
2
4$

+, 

+, 

+, 

�

��"������
���

&2�� �255

�

�
�5
�
�4

-%�$

&2�$

�25$
�25� &2�5

 ��

����

 ��

-�

.2"3 .2".2"5

/$�0

+, 

/����0
�&(�

.
�

6��#78.#

6�89�

01*#
!2#

%*�

%*�

%*$

%*5

%1�

%1�

%1$

%15

%&�

%&�

%&$

%&5

%!�

%!�

%!$

%!5

% �
:,�

% �
:,�
% $
:,$
% 5
:,5

0�!;

+, 

6����

6����	


%*)

%*�

%*"

%*'

%1)

%1�

%1"

%1'

%&)

%&�

%&"

%&'

%!)

%!�

%!"

%!'

% )
:,)

% �
:,�
% "
:,"
% '
:,'

&0#

��
�

-%
�"

-%
�� &
�"

&
��

&
�) &
4

&
5

&
3

&
��

&
��

��)

�
4

�
'

�
"

�
�

�
$

�
5

��)

�
�4

�
�'

�
�"

�
��

�
�$

�
�5

��3

-%
��

-%
�$

-%
�3

-%
��


�
��


�
��


�
��

-%
��

��3

�3

�2$5�2$$
�235

�2"3

.
2
��

.
2
��

�
2
43

.2�
.
2
�5

.
2
"�

.
2
"�

�
2
'�

�
2
'$

�
2
'�

�2$3

�
�'

��$

<�

&�$

&
�3

&
�)

.�

&�4

&
�5

-%�'
-%'
-%$

���
-%"
-%�

���
-%4
-%5
-%�4
-%3
-%�)

&�'

:�
&'

&$

*+
, 

&
0
#

:,
'�
,

:,
"�
,

:,
��
,

:,
)�
,

0
�
!
;

:,
5�
,

:,
$�
,

:,
��
,

:,
��
,

*
+
,
 

*
+
,
 

�
��

�
��

�
2
"5

�2"�

�
�"

&
4

&
5

&
3

&��

&�"

:'

:5

&�$

&
��:$

:"

�
�)

-�

&
"�

�
�$

 
�
�

 
�
�

��5

��'

*&
#

:�,
=

&
5�

>
�

&5�

.
�5

&
''

�"'

.�4

�
"5

&
$�

&
$"

&
$�

&
$�

&
$)

&"3

&"5

&
"4

.
5 &"�

&"�

.
'

&�"
&�$

>
�

.
$

�
�$

&
��

�
�"

&
�)

<
�

#�

&�4

:� �5
�'

:�

&
�'

&��

:3:4

�
$

�
"

�
�

�
�

�
�

�
4�$�&
�)

.
�

�
3

�
�)

-%�

-%�

-%
�

.
�

&��
&��

�
%
�

�"�

 
�

�
�5��4-%"��� ���

���

>
�

�
"4
&
$$ &$' &"'

&"$&"".
3

��)

&�4

.
4

&�'

�
�'

&��

&
�)
&
��

��3

&
�3

&
�4

&
�'
&
�5

&�"
&�$

-�

����	


��
�
����

�����
����	
��������	

��
�����	�������
���

��	��������������	��&

�

�������


��
�
����

'�

&������
����

#�
%
&
�.
�
1
��
��
�

%
�
8
+

 
�*
+

�����
�����
�
���

%
�
8
+

-�

Once all the ot

If you have the
selecting the ap
adapter as show

Connect the A
connector may
always connec

Plug in the AC
should light up

NOTE:
ware

Run a Sam
Once the RCM
on the Dynamic
during installat
selected to supp
Use the File me
Press function k
display a small 
Troubleshoo
If Dynamic C c

• Check that th
lit when the 

• Check both 
PROG conn
with the mar

• Ensure that t

• If a program
is possible th
log in the Dy
Max downlo
Press the module’s pins gently into the Prototyping Board header socket—press down in the area above the 
header pins—and snap the plastic standoffs into the mounting holes. Optional metal standoffs and 4-40 screws 
included in the bag of parts may be used instead.

Step 3 — Connect Programming Cable
The programming cable connects the RCM4010 to the PC running Dynamic C to download programs and to 
monitor the RCM4010 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J1 on the RCM4010 as shown in 
Figure 3. Be sure to orient the marked (usually red) edge of the cable towards pin 1 of the connector. (Do not use 
the DIAG connector, which is used for a normal serial connection.)

Connect the other end of the programming cable to an available USB port on your PC or workstation. Your PC 
should recognize the new USB hardware, and the LEDs in the shrink-wrapped area of the USB programming cable 
will flash.

• Select a different COM port within Dynamic C. You may have to determine which COM port was assigned 
to the USB programming cable. Open Control Panel > System > Hardware > Device Manager > 
Ports and identify which COM port is used for the USB connection. In Dynamic C, select Options > 
Project Options, then select this COM port on the Communications tab, then click OK. You may 
type the COM port number followed by Enter on your computer keyboard if the COM port number is 
outside the range on the dropdown menu. If Dynamic C still reports it is unable to locate the target sys-
tem, repeat the above steps until you locate the active COM port.

• If you get an error message when you plugged the programming cable into a USB port, you will have to 
install USB drivers. Drivers for Windows XP are available in the Dynamic C Drivers\Rabbit USB 
Programming Cable\WinXP_2K folder — double-click DPInst.exe to install the USB drivers. 
Drivers for other operating systems are available online at www.ftdichip.com/Drivers/VCP.htm.

Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. The LEDs on the USB programming cable 
will blink and you should receive a Bios compiled successfully message. 

http://www.ftdichip.com/Drivers/VCP.htm


Hardware Connections
Step 1 — Prepare the Prototyping Board
To facilitate handling the Prototyping Board, snap in four plastic 
standoffs to the four holes at the corners from the bottom side of 
the Prototyping Board as shown in Figure 1.

Step 2 — Attach Module to Prototyping Board
Turn the RCM4010 module so that the mounting holes of the 
RCM4010 line up with the corresponding holes on the Proto-
typing Board. Insert a standoff as shown, then insert the mod-
ule’s header J3 on the bottom side into header socket RCM1 
on the Prototyping Board.

NOTE: It is important that you line up the pins on header J3 of the RCM4010 module exactly with socket RCM1 on the 
Prototyping Board. The header pins may become bent or damaged if the pin alignment is offset, and the module will not 
work. Permanent electrical damage to the module may also result if a misaligned module is powered up.

Press the module’s pins gently into the Prototyping Board header socket—press down in the area above the 
header pins—and snap the plastic standoffs into the mounting holes. Optional metal standoffs and 4-40 screws 
included in the bag of parts may be used instead.

Step 3 — Connect Programming Cable
The programming cable connects the RCM4010 to the PC running Dynamic C to download programs and to 
monitor the RCM4010 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J1 on the RCM4010 as shown in 
Figure 3. Be sure to orient the marked (usually red) edge of the cable towards pin 1 of the connector. (Do not use 
the DIAG connector, which is used for a normal serial connection.)

Connect the other end of the programming cable to an available USB port on your PC or workstation. Your PC 
should recognize the new USB hardware, and the LEDs in the shrink-wrapped area of the USB programming cable 
will flash.

Figure 2.  Install the RCM4010 Module
on the Prototyping Board

Figure 3.  Connect Programming Cable and 
Power Supply

Figure 1.  Insert Standoffs
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Step 4 — Connect Power
Once all the other connections have been made, you can connect power to the Prototyping Board.

If you have the universal AC adapter, prepare the AC adapter for the country where it will be used by 
selecting the appropriate plug. Snap in the top of the plug assembly into the slot at the top of the AC 
adapter as shown in Figure 3, then press down on the plug until it clicks into place.

Connect the AC adapter to 3-pin header J1 on the Prototyping Board as shown in Figure 3 above. The 
connector may be attached either way as long as it is not offset to one side—the center pin of J1 is 
always connected to the positive terminal, and either edge pin is ground.

Plug in the AC adapter. The PWR LED on the Prototyping Board next to the power connector at J1 
should light up. The RCM4010 and the Prototyping Board are now ready to be used.

NOTE: A RESET button is provided on the Prototyping Board next to the battery holder to allow a hard-
ware reset without disconnecting power.

Run a Sample Program
Once the RCM4010 is connected as described in the preceding pages, start Dynamic C by double-clicking 
on the Dynamic C icon on your desktop or in your Start menu. Dynamic C uses the serial port specified 
during installation. Select the “Communications” tab and verify that Use USB to Serial Converter is 
selected to support the USB programming cable. Click OK.
Use the File menu to open the sample program PONG.C, which is in the Dynamic C SAMPLES folder. 
Press function key F9 to compile and run the program.The STDIO window will open on your PC and will 
display a small square bouncing around in a box.
Troubleshooting
If Dynamic C cannot find the target system (error message "No Rabbit Processor Detected."):

• Check that the RCM4010 is powered correctly — the red PWR LED on the Prototyping Board should be 
lit when the RCM4010 is mounted on the Prototyping Board and the AC adapter is plugged in.

• Check both ends of the programming cable to ensure that they are firmly plugged into the PC and the 
PROG connector, not the DIAG connector, is plugged in to the programming port on the RCM4010 
with the marked (colored) edge of the programming cable towards pin 1 of the programming header.

• Ensure that the RCM4010 module is firmly and correctly installed in its socket on the Prototyping Board.

• If a program compiles and loads, but then loses target communication before you can begin debugging, it 
is possible that your PC cannot handle the default debugging baud rate. Locate the Serial Options dia-
log in the Dynamic C Options > Project Options > Communications menu. Select a slower 
Max download baud rate, or choose a lower debug baud rate, then click OK.

• Select a different COM port within Dynamic C. You may have to determine which COM port was assigned 

to the USB programming cable. Open Control Panel > System > Hardware > Device Manager > 
Ports and identify which COM port is used for the USB connection. In Dynamic C, select Options > 
Project Options, then select this COM port on the Communications tab, then click OK. You may 
type the COM port number followed by Enter on your computer keyboard if the COM port number is 
outside the range on the dropdown menu. If Dynamic C still reports it is unable to locate the target sys-
tem, repeat the above steps until you locate the active COM port.

• If you get an error message when you plugged the programming cable into a USB port, you will have to 

install USB drivers. Drivers for Windows XP are available in the Dynamic C Drivers\Rabbit USB 
Programming Cable\WinXP_2K folder — double-click DPInst.exe to install the USB drivers. 
Drivers for other operating systems are available online at www.ftdichip.com/Drivers/VCP.htm.

Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. The LEDs on the USB programming cable 
will blink and you should receive a Bios compiled successfully message. 

http://www.ftdichip.com/Drivers/VCP.htm


SMB Network Storage Application Kit
The SMB Network Storage Application Kit allows you to add an SMB server to a Rabbit-based system 
that enables file sharing to add attached storage. Sample programs show you how to create a new file on 
the server and write data to it, and provide an interactive command-line shell.

Application Kit Contents
• 2 CD-ROMs — Dynamic C® with complete product documentation on disk, and supplemental CD 

with sample programs and information related to the SMB Application Kit.

• Network Storage Center with AC power supply, international adapter plugs, setup CD, and instruc-
tions.

• 3.5" IDE hard drive.

• RCM4010 RabbitCore® module.

• Prototyping Board.

• Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z., U.K., and 
European style plugs). Application Kits sold in North America may contain an AC adapter with 
only a North American style plug.

Network Storage Center Setup
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Quick Start Guide
1. Install Dynamic C, then run the executable on the supplemental CD to add the SMB Application Kit soft-

ware.

2. Attach RCM4010 module to Prototyping Board, connect programming cable to PC, connect AC adapter.

3. Install the hard drive in the Network Storage Center and configure the Network Storage Center via your PC.

4. Use an Ethernet cable to connect the RCM4010 to the configured Network Storage Center

5. Explore the sample programs in the Dynamic C SAMPLES\ThinShare folder.
. Install the hard drive in the Network Storage Center as shown at right.

. Plug in the AC power adapter and use either a straight-through or a cross-
over Ethernet cable to connect the Network Storage Center to your PC.

. If you are using Windows Vista, set the firewall to “Private.”

. Install the IP Scanner utility from the setup CD that came with the Network 
Storage Center.

. Use the on/off switch to turn the Network Storage Center on, then restart 
your PC to obtain a new IP address from the Network Storage Center.

. Point your Web browser to http: //169.254.0.1/. A login dialog will 
appear. The default username and password are both admin.

. Change the Host Name to thindrive to match the Dynamic C REMOTE_
SERVER macro in the LIB\ThinShare\SMB_CONFIG.LIB library.

. Click on Samba Server and add SAMPLES to the folder list.

TIP: The Network Storage Center has a DHCP server. Leave the DHCP 
server on the Status tab enabled as long as you plan to connect the 
RCM4010 directly to the Network Storage Center or via a network 
without a DHCP server. You must disable the Network Storage Center’s 
DHCP server if your connection to the RCM4010 is via a network with a DHCP server. 

here Do I Go From Here?
ou are now ready to run the SMB sample programs in the Dynamic C SAMPLES\ThinShare folder. Use ei
traight-through or a crossover Ethernet cable to connect the Network Storage Center to the RCM4010 Ethern

TIP: The sample programs assume that the Network Storage Center and the RCM4010 will be conn
with a DHCP server present. If you make a direct connection where there is no DHCP server, chan
TCPCONFIG 3 macro in the sample programs to TCPCONFIG 1 before you compile and run the
programs. You will have to assign a static IP address (default IP 10.10.60.100, Subnet Mask 255.25
and Gateway 10.10.6.1) to the Network Storage Center.

he SMBSHELL.C is a good first sample program to run to display an interactive command-line shell with a
umber of common SMB commands in the Dynamic C STDIO window.

f the sample program ran fine, you are now ready to go on to other sample programs and to develop your ow
ations. The source code for the sample programs is provided to allow you to modify them for your own use.
mbeo Getting Started and Samples manual and ThinShare User’s Manual on the supplemental CD contain
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• Bag containing accessory parts, screws, washers, and standoffs.

• USB programming cable with 10-pin header.

• Cat. 5 Ethernet crossover cable.

• Getting Started instructions.

• Rabbit 4000 Processor Easy Reference poster.

• Registration card.

Visit our online Rabbit store at www.rabbit.com/store/ for 
the latest information on peripherals and accessories that 
are available for all RCM4000 RabbitCore module models.

ional setup information, describe the sample programs, and provide a complete technical reference for the ThinShare 
ibrary and function calls. The RCM4000 User's Manual on the Dynamic C CD also provides complete hardware 
eference information and describes the software function calls for the RCM4010 RabbitCore modules and the Proto-
yping Board. The Setup CD has a reference manual for the Network Storage Center.

f there are any other problems:

Use the Dynamic C Help menu to get further assistance with Dynamic C.

Check the Rabbit Semiconductor Technical Bulletin Board and forums at www.rabbit.com/support/bb/ and at 
www.rabbit.com/forums/.

Use the Technical Support e-mail form at www.rabbit.com/support/.

NOTE: If you purchased your SMB Application Kit through a distributor or through a Rabbit partner, contact 
the distributor or partner first for technical support.

Installing Dynamic C®

Insert the Dynamic C CD from the Appli-
cation Kit in your PC’s CD-ROM drive. If 
the installation does not auto-start, run the 
setup.exe program in the root directory 
of the Dynamic C CD. Run the executable 
from the supplemental CD to install the 
SMB software after you install Dynamic C.

http://www.zworld.com/support/bb/index.html
http://www.rabbitsemiconductor.com/forums/
http://www.rabbit.com/support/questionSubmit.shtml
http://www.rabbit.com/store/



